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16.  List of Appendices 

 

 

Welcome to the appendix. 

 

Here you will find the additional documentation that will help with the interpretation 

and understanding of the bachelor’s thesis of Mr. Alfaro. In this appendix, all of the 

content will be linked to the memory so that there is a connectivity between both of the 

documents.  

 

_____________________________________________________________________ 

a. Appendix Ⅰ – Visual representation of each 

boundary conditions, followed by the result of each 

study case 

___________________________________________________________ 

 

Structural Steel S235 frame: 

 
Case 1 - Vertical loads – Boundary conditions - Structure steel S235; 

 

 
 

 
Figure 1. Boundary and forces for structure steel S235 case number 1 - view 1. 
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 Table 1. Detailed table of loads and restrictions for case 1 of the Structure steel S235. 

 

Definition 

Type Force Remote Displacement Force 

Define By Vector   Vector 

Magnitude 
-1.3439e+005 N 

(ramped) 
  

-1.3439e+005 N 

(ramped) 

Direction Defined   Defined 

Suppressed No 

X Component   0.01 m (ramped)   

Y Component   0.01 m (ramped)   

Z Component   0. m (ramped)   

Rotation X    
0.1 ° 

(ramped) 
  

Rotation Y    0. ° (ramped)   

Rotation Z    0. ° (ramped)   

Behavior   Deformable Coupled   

Rotation X    
0.1 ° 

(ramped) 
  

Rotation Y    0. ° (ramped)   

Rotation Z    0. ° (ramped)   

Advanced 

Pinball 

Region 
  All   

 

Like calculated previously, the force would be a value of 𝐹 = 134387.2 N ≅
𝟏𝟑𝟒𝟑𝟖𝟖 𝑵 and the restrictions – (x, y, z) = (0.01, 0.01, 0) & (Rx, Ry, Rz) = (0.1, 0, 0).  

 

  

Figure 2. Boundary and forces for structure steel S235 case number 1 - view 2. 
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Case 1 - Vertical loads – Results - Structure steel S235: 

 

Total deformation: 
 

 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

Figure 3. Total deformation 1 - structure steel - case 1 

Figure 4. Total deformation 2 - structure steel - case 1 



______________________________________________________________________ 

13 

 

Von-Misses stress: 
 

 
 

 
 

 

 
 

 
 

 

 

 

 

 

 

 

 

 

Safety factor: 

Figure 5. Von-Mises stress 1 - structure steel - case 1 

Figure 6. Von-Mises stress 2 - structure steel - case 1 
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Figure 7. Safety factor 1 - structure steel - case 1 

Figure 8. Safety factor 2 - structure steel - case 1 
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Case 2  - Lateral loads – Boundary conditions - Structure steel S235; 

 

 
 

 

 

 

 

  

Figure 9. Boundary and lateral load for structure steel S235, view 1. 

Figure 10. Boundary and lateral loads for structure steel S235, view 2. 
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Table 2. Detailed table of loads and restrictions for case 2 of the Structure steel S235.  

Definition 

Type Force Remote Displacement Force 

Define By Vector   Vector 

Magnitude 
-72344 N 

(ramped) 
  

-72344 N 

(ramped) 

14000 N 

(ramped) 

-1.3439e+005 

N (ramped) 

Direction Defined   Defined 

Suppressed No 

X 

Component 
  0.01 m (ramped)   

Y 

Component 
  0.01 m (ramped)   

Z 

Component 
  0. m (ramped)   

Rotation X    
0.1 ° 

(ramped) 
  

Rotation Y    
0. ° 

(ramped) 
  

Rotation Z    
0. ° 

(ramped) 
  

Behavior   Deformable   

Rotation X    
0.1 ° 

(ramped) 
  

Rotation Y    
0. ° 

(ramped) 
  

Rotation Z    
0. ° 

(ramped) 
  

Advanced 

Pinball 

Region 
  All  
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Case 2 – Lateral loads – Results - Structure steel S235: 

 

Total deformation: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 11. Total deformation 1 - structure steel - case 2 

Figure 12. Total deformation 2 - structure steel - case 2 
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Von-Misses stress: 

 

 
 

 
 

 
 

 
 

 

 

 

 

 

 
 

Figure 13. Von-Mises stress 1 - structure steel - case 2. 

Figure 14. Von-Mises stress 2 - structure steel - case 2 
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Safety factor: 

 

 
 

 
 

 
 

 
 

  

Figure 15. Safety factor 1 - structure steel - case 2. 

Figure 16. Safety factor 2 - structure steel - case 2 
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Case 3  - Unloading loads – Boundary conditions - Structure steel S235; 

 

 
 

 
 

 
 

 
 

  

Figure 17. Boundary and unloading loads for structure steel S235, view 1. 

Figure 18. Boundary and unloading forces for structure steel S235, view 2. 
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Table 3. Detailed table of loads and restrictions for case 3 of the Structure steel S235. 

Definition 

Type Force Remote Displacement 

Define By Vector   

Magnitude 
-44145 N 

(ramped) 
  

Direction Defined   

Suppressed No 

X 

Component 
  0.01 m (ramped) 

Y 

Component 
  0.01 m (ramped) 

Z Component   
0.01 m 

(ramped) 

0. m 

(ramped) 

0.01 m 

(ramped) 

0. m 

(ramped) 

Rotation X    
0.1 ° 

(ramped) 
  

Rotation Y    
0.1 ° 

(ramped) 
  

Rotation Z    
0.1 ° 

(ramped) 
  

Behavior   Deformable 

Rotation X    
0.1 ° 

(ramped) 
  

Rotation Y    
0. ° 

(ramped) 
  

Rotation Z    
0. ° 

(ramped) 
  

Rotation X    
0.1 ° 

(ramped) 
  

Rotation Y    
0.1 ° 

(ramped) 
  

Rotation Z    
0.1 ° 

(ramped) 
  

Rotation X    
0.1 ° 

(ramped) 

Rotation Y    
0. ° 

(ramped) 

Rotation Z    
0. ° 

(ramped) 

Advanced 

Pinball 

Region 
  All 
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Case 3  - Unloading loads – Results - Structure steel S235; 

 

Total deformation: 

 

 
 

 
 

 
 

 
 

 

 

  

Figure 19. Total deformation - structure steel - case 3 

Figure 20.Total deformation 2 - structure steel - case 3. 
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Von-Misses stress: 
 

 
 

Figure 21. Von-Mises stress - structure steel - case 3. 

 

 
 

Figure 22. Von-Mises stress 2 - structure steel - case 3. 

 

 

 

 

 
 

Safety factor: 
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Figure 23. Safety factor - structure steel - case 3. 

Figure 24. Safety factor 2 - structure steel - case 3. 
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Case 4  - Lonzening loads – Boundary conditions - Structure steel S235; 

 

 

 
 

 

 

 
 

 

  

Figure 25. Boundary and lozenging loads for structure steel S235, view 1. 

Figure 26. Boundary and lozenging loads for structure steel S235, view 2. 
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Table 4. Detailed table of loads and restrictions for case 4 of the Structure steel S235. 

Definition 

Object 

Name 

Remote 

Displacement 

Remote 

Displacement 

2 

Force 
Force 

2 

Force 

3 

Force 

4 

Force 

5 

Force 

6 

Type Remote Displacement Force 

X 

Component 
0.01 m (ramped) 0. N (ramped) 

Y 

Component 
0.01 m (ramped) 

31783 N 

(ramped) 

-31783 N 

(ramped) 
0. N (ramped) 

Z 

Component 
0. m (ramped) 0. N (ramped) -134388 N (ramped) 

Rotation X  
0.1 ° 

(ramped) 
  

Rotation Y  0. ° (ramped)   

Rotation Z  0. ° (ramped)   

Suppressed No 

Behavior Deformable   

Rotation X    
0.1 ° 

(ramped) 
  

Rotation Y    0. ° (ramped)   

Rotation Z    0. ° (ramped)   

Define By   Components 

Coordinate 

System 
  Global Coordinate System 

Advanced 

Pinball 

Region All  
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Case 4  - Lonzening loads – Results - Structure steel S235; 

 

Total deformation: 

 

 
 

 
 

 
 

 
 

Figure 27. total deformation 1 - structure steel - case 4 

Figure 28. total deformation 2 - structure steel - case 4 
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Von-mises stress  

 

 

 

 

 

  

Figure 29. Von-Mises stress 1 - structure steel - case 4. 

Figure 30. Von-Mises stress 2 - structure steel - case 4 
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Safety factor: 

 

 

 

 

 

  

Figure 31. Safety factor 1 - structure steel - case 4 

Figure 32. Safety factor 2 - structure steel - case 4 
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Case 5  - Longitudinal loads – Boundary conditions - Structure steel S235; 

 

 

 

 
 

  

Figure 33. Boundary and longitudinal shunting loads for structure steel S235, view 1. 

Figure 34. Boundary and longitudinal shunting loads for structure steel S235, view 2. 
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Table 5. Detailed table of loads and restrictions for case 5 of the Structure steel S235. 

Definition 

Object 

Name 

Remote 

Displacement 

Remote 

Displacement 

2 

Force 

1 

Force 

2 

Force 

3 

Force 

4 

Force 

5 

Force 

6  

   

Type Remote Displacement Force 

X 

Component 
0.01 m (ramped) 0. N (ramped) 

Y 

Component 
0.01 m (ramped) 16628 N (ramped) 0. N (ramped) 

Z 

Component 
0. m (ramped) 0. N (ramped) 

-134388 N 

(ramped) 

Rotation X  
0.1 ° 

(ramped) 
  

Rotation Y  0. ° (ramped)   

Rotation Z  0. ° (ramped)   

Suppressed No 

Behavior Deformable   

Rotation X    
0.1 ° 

(ramped) 
  

Rotation Y    0. ° (ramped)   

Rotation Z    0. ° (ramped)   

Define By   Components 

Coordinate 

System 
  Global Coordinate System 

Advanced 

Pinball 

Region 

All 
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Case 5  - Longitudinal loads – Results - Structure steel S235; 

 

Total deformation: 

 

 

 

 

 

  

Figure 35. Total deformation 1 - structure steel - case 5 

Figure 36. Total deformation 2 - structure steel - case 5 
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Von-Misses stress: 

 

 

 

 

 

 

  

Figure 37. Von-mises stress 1 - structure steel - case 5 

Figure 38. Von-Mises stress 2 - structure steel - case 5 
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Safety factor: 

 

 

 

 
 

 

 

 
  

Figure 39. Safety factor 1 - structure steel - case 5 

Figure 40. Safety factor 2 - structure steel - case 5 
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Case 6  - Fatigue vertical loads – Boundary conditions - Structure steel 

S235; 

 

 

 

 

Figure 42. Boundary and vertical fatigue load for structure steel S235, view 2. 

 

 

 

  

Figure 41. Boundary and vertical fatigue load for structure steel S235, view 1. 
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Table 6. Detailed table of loads and restrictions for case 6 of the Structure steel S235.  

Object Name Force 
Remote 

Displacement 

Remote 

Displacement 2 
Force 2 

Definition 

Type Force Remote Displacement Force 

Define By Vector   Vector 

Magnitude 
-91734 N 

(ramped) 
  

-91734 N 

(ramped) 

Direction Defined   Defined 

Suppressed No 

X 

Component 
  0.01 m (ramped)   

Y 

Component 
  0.01 m (ramped)   

Z 

Component 
  0. m (ramped)   

Rotation X    0.1 ° (ramped)   

Rotation Y    0. ° (ramped)   

Rotation Z    0. ° (ramped)   

Behavior   Deformable Coupled   

Rotation X    0.1 ° (ramped)   

Rotation Y    0. ° (ramped)   

Rotation Z    0. ° (ramped)   

Advanced 

Pinball 

Region 
  All  
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Case 6  - Vertical fatigue loads – Results - Structure steel S235; 

 

Safety factor: 

 

 

Life expentancy: 

 

 
 

 
  

Figure 43. Safety factor (fatigue) - structure steel - case 6 

Figure 44. Life expectancy (fatigue) - structure steel - case 6 
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Case 7  - Fatigue Lateral loads – Boundary conditions - Structure steel 

S235; 

 

 
 

 

 

 

 

  

Figure 45. Boundary and lateral fatigue load for structure steel S235, view 1. 

Figure 46. Boundary and lateral fatigue load for structure steel S235 s, view 2. 
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Table 7. Detailed table of loads and restrictions for case 7 of the Structure steel S235. 

Object 

Name 

Remote 

Displacement 

Remote 

Displacement 2 

Force 

1 

Force 

2 
Force 3 & 4 

Definition 

Type Remote Displacement Force 

X 

Component 
0.01 m (ramped)   

Y 

Component 
0.01 m (ramped)   

Z 

Component 
0. m (ramped)   

Rotation X  0.1 ° (ramped)   

Rotation Y  0. ° (ramped)   

Rotation Z  0. ° (ramped)   

Suppressed No 

Behavior Deformable   

Rotation X    0.1 ° (ramped)   

Rotation Y    0. ° (ramped)   

Rotation Z    0. ° (ramped)   

Define By   Vector 

Magnitude   
-29065 N 

(ramped) 

-91734 N 

(ramped) 

Direction   Defined 

Advanced 

Pinball 

Region 
All   
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Case 7  - Lateral fatigue loads – Results - Structure steel S235; 

 

Safety factor: 

 

 

Life expectancy: 

 

 

  

Figure 47. Safety factor (fatigue) - structure steel - case 7 

Figure 48. Life expectancy (fatigue) - structure steel - case 7 
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Case 8  - Fatigue Lonzenging loads – Boundary conditions - Structure steel 

S235; 

 

 

 

Figure 50. Boundary and lozenging fatigue load for structure steel S235, view 2. 

  

Figure 49. Boundary and lozenging fatigue load for structure steel S235, view 1. 



______________________________________________________________________ 

42 

 

Table 8. Detailed table of loads and restrictions for case 8 of the Structure steel S235.   

Object 

Name 

Remote 

Displacement 

Remote 

Displacement 

2 

Force 
Force 

2 

Force 

3 

Force 

4 

Force 

5 

Force 

6 

Definition 

Type Remote Displacement Force 

X 

Component 
0.01 m (ramped) 0. N (ramped) 

Y 

Component 
0.01 m (ramped) 

11626 N 

(ramped) 

-11626 N 

(ramped) 
0. N (ramped) 

Z 

Component 
0. m (ramped) 0. N (ramped) 

-91734 N 

(ramped) 

Rotation X  
0.1 ° 

(ramped) 
  

Rotation Y  0. ° (ramped)   

Rotation Z  0. ° (ramped)   

Suppressed No 

Behavior Deformable   

Rotation X    
0.1 ° 

(ramped) 
  

Rotation Y    0. ° (ramped)   

Rotation Z    0. ° (ramped)   

Define By   Components 

Coordinate 

System 
  Global Coordinate System 

Advanced 

Pinball 

Region 
All   
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Case 8  - Lonzenning fatigue loads – Results - Structure steel S235; 

 

Safety factor: 

 

 
 

 

 

 

 

 

 

 

Figure 51. Safety factor (fatigue) - structure steel - case 8 

Figure 52. Safety factor (fatigue) - structure steel - case 8 
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Life expectancy: 

 

 

  
Figure 53. Life expectancy (fatigue) - structure steel - case 8 
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Composite material frame: 

 
Case 1  - Vertical loads – Boundary conditions – Composite frame; 

 

 
 

 
 

 

 

  

Figure 54. Boundary and forces for CFRP case number 1 - view 1. 

Figure 55. Boundary and forces for CFRP case number 1 - view 2. 
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Table 9. Detailed table of loads and restrictions for case 1 of the CFRP. 

Object 

Name 

Remote 

Displacement 

Remote 

Displacement 2 

Remote 

Displacement 3 

Remote 

Displacement 4 
Force Force 2 

Definition 

Type Remote Displacement Force 

X 

Component 
0.01. m (ramped)   

Y 

Component 
0.01. m (ramped)   

Z 

Component 
0. mm (ramped)   

Rotation X  0.1 ° (ramped)   

Rotation Y  0. ° (ramped)   

Rotation Z  0. ° (ramped)   

Suppressed No 

Behavior Deformable   

Rotation X    0.1 ° (ramped)   

Rotation Y    0. ° (ramped)   

Rotation Z    0. ° (ramped)   

Rotation X    0.1 ° (ramped)   

Rotation Y    0. ° (ramped)   

Rotation Z    0. ° (ramped)   

Rotation X    0.1 ° (ramped)   

Rotation Y    0. ° (ramped)   

Rotation Z    0. ° (ramped)   

Define By   Vector 

Magnitude   
1.477e+005 N 

(ramped) 

Advanced 

Pinball 

Region 
All   
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Case 1  - Vertical loads – Results – Composite frame; 

 

Total deformation: 
 

 
 

 

 

 

 

Figure 56. Total deformation 1 - CFRP - case 1. 

Figure 57. Total deformation 2 - CFRP - case 1 
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Von-Misses stress: 

 

 
 

 

 

 
 

  

Figure 58. Von-Misses stress 1 - CFRP - case 1 

Figure 59. Von-Misses stress 2 - CFRP - case 1 
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Inverse fail factor: 
 

 
 

 
 

 

 
 

 

 

 

Figure 60. Inverse fail factor 1 - CFRP - case 1 

Figure 61. Inverse fail factor 2 - CFRP - case 1 
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Safety factor: 

 

 
 

 
 

  

Figure 62. Safety factor - CFRP - case 1 
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Case 2  - Lateral  loads – Boundary conditions – Composite Frame; 

 

 

 

 

 

 

  

Figure 63. Boundary and forces for CFRP case number 2 - view 1. 

Figure 64. Boundary and forces for CFRP case number 2 - view 2. 
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Table 10. Detailed table of loads and restrictions for case 2 of the CFRP. 

 

Object 

Name 

Remote 

Displacement 

Remote 

Displacement 

2 

Remote 

Displacement 

3 

Remote 

Displacement 

4 

Force Force 2 
Force 

3 

Force 

4 

Force 

5 

Force 

6 

Definition 

Type Remote Displacement Force 

X 

Component 
0.01. m (ramped) 

 1.477e+005 N 

(ramped) 

14000 N 

(ramped) 

63882 N 

(ramped) 

Y 

Component 
0.01. m (ramped)   

Z 

Component 
0. mm (ramped)   

Rotation X  
0.1 ° 

(ramped) 
  

Rotation Y  0. ° (ramped)   

Rotation Z  0. ° (ramped)   

Suppressed No 

Behavior Deformable   

Rotation X    
0.1 ° 

(ramped) 
  

Rotation Y    0. ° (ramped)   

Rotation Z    0. ° (ramped)   

Rotation X    
0.1 ° 

(ramped) 
  

Rotation Y    0. ° (ramped)   

Rotation Z    0. ° (ramped)   

Rotation X    
0.1 ° 

(ramped) 
  

Rotation Y    0. ° (ramped)   

Rotation Z    0. ° (ramped)   

Define By    

Magnitude   
 

  
Advanced 

Pinball 

Region 
All   
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Case 2  - Lateral loads – Results – Composite Frame; 

 

Total deformation: 

 

 
 

 
 

 
 

 
  

Figure 65. Total deformation 1 - CFRP - case 2. 

Figure 66. Total deformation 2 - CFRP - case 2. 
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Von-Misses stress: 

 

 

 
 

 

 

  

Figure 67. Von-misses stress 1 - CFRP - case 2. 

Figure 68. Von-misses stress 2 - CFRP - case 2. 
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Inverse fail factor: 

 

 
 

 
 

 

 

 

 

Figure 69. Inverse reverse fails 1 - CFRP - case 2. 

Figure 70. Inverse reverse fails 2 - CFRP - case 2. 
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Safety Factor: 

 

 
 

 
  

Figure 71. Safety factor - CFRP - case 2. 
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Case 3  - Unloading loads – Boundary conditions – Composite Frame; 

 

 

 

 

 

  

Figure 72. Boundary and forces for CFRP case number 3 - view 1. 

Figure 73.Boundary and forces for CFRP case number 3 - view 2. 
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Table 11. Detailed table of loads and restrictions for case 3 of the CFRP. 

Object 

Name 

Remote 

Displacement 

Remote 

Displacement 2 

Remote 

Displacement 3 

Remote 

Displacement 4 
Force 

Force 

2 

State Fully Defined 

Definition 

Type Remote Displacement Force 

X 

Component 
0.01. m (ramped)   

Y 

Component 
0.01. m (ramped)   

Z 

Component 

10. mm 

(ramped) 
0. mm (ramped) 10. mm (ramped)   

Rotation X  0.1 ° (ramped)   

Rotation Y  0.1 ° (ramped)   

Rotation Z  0.1 ° (ramped)   

Suppressed No 

Behavior Deformable   

Rotation X    0.1 ° (ramped)   

Rotation Y    0. ° (ramped)   

Rotation Z    0. ° (ramped)   

Rotation X    0.1 ° (ramped)   

Rotation Y    0. ° (ramped)   

Rotation Z    0. ° (ramped)   

Rotation X    0.1 ° (ramped)   

Rotation Y    0.1 ° (ramped)   

Rotation Z    0.1 ° (ramped)   

Define By   Vector 

Magnitude   
53692 N 

(ramped) 

Advanced 

Pinball 

Region 
All  
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Case 3  - Unloading loads – Results – Composite Frame; 

 

Total deformation: 

 

 
 

 

 

 

 

Figure 74. Total deformation 1 - CFRP - case 3. 

Figure 75. Total deformation 2 - CFRP - case 3. 



______________________________________________________________________ 

60 

 

 

 

Von-Misses stress: 

 

 
 

  

Figure 76. Total deformation 3 - CFRP - case 3. 

Figure 77. Von-Misses stress 1 – CFRP - case 3. 
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Inverse fail factor: 

 

 

 

 

Figure 78. Von-Misses stress 2 - CFRP - case 3. 

Figure 79. Inverse fail factor 1 - CFRP - case 3. 
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Safety factor: 

 

 

 
 

  

Figure 80. Inverse fail factor 2 - CFRP - case 3. 

Figure 81. Safety factor - CFRP - case 3. 
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Case 4  - Lonzening loads – Boundary conditions – Composite Frame; 

 

 

 

  

Figure 82. Boundary and forces for CFRP case number 4 - view 1. 

Figure 83. Boundary and forces for CFRP case number 4 - view 2. 
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Table 12. Detailed table of loads and restrictions for case 4 of the CFRP. 

Object 

Name 

Remote 

Displacement 

Remote 

Displacement 

2 

Remote 

Displacement 

3 

Remote 

Displacement 

4 

Force 
Force 

2 

Force 

3 

Force 

4 

Force 

5 

Force 

6 

Definition 

Type Remote Displacement Force 

X 

Component 
0.01. m (ramped)    

Y 

Component 
0.01. m (ramped)   

-9646. N 

(ramped) 

9646. N 

(ramped) 

Z 

Component 
0. mm (ramped) 

1.4775e+005 N 

(ramped)  
 

Rotation X  0.1 ° (ramped)   

Rotation Y  0. ° (ramped)   

Rotation Z  0. ° (ramped)   

Suppressed No 

Behavior Deformable   

Rotation X    0.1 ° (ramped)   

Rotation Y    0. ° (ramped)   

Rotation Z    0. ° (ramped)   

Rotation X    0.1 ° (ramped)   

Rotation Y    0. ° (ramped)   

Rotation Z    0. ° (ramped)   

Rotation X    0.1 ° (ramped)   

Rotation Y    0. ° (ramped)   

Rotation Z    0. ° (ramped)   

Define By    

Magnitude      

Advanced 

Pinball 

Region 
All   
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Case 4  - Lonzening loads – Results – Composite Frame; 

Total deformation: 

 

 

 

 

 

 

Figure 84. Total deformation 1 - CFRP - case 4. 

Figure 85. Total deformation 2- CFRP - case 4. 
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Von-Misses stress: 

 

 

 

 

 

 

 

Figure 86. Von-misses stress 1 - CFRP - case 4. 

Figure 87. Von-misses stress 2 - CFRP - case 4. 
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Inverse fail factor: 

 

 

 

  

Figure 88. Inverse fail factor 1 - CFRP - case 4. 

Figure 89. Inverse fail factor 2 - CFRP - case 4. 
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Safety Factor: 

 

 

  

Figure 90. Safety factor - CFRP - case 4. 
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Case 5  - Longitudinal loads – Boundary conditions – Composite Frame; 

 

 

 

 

  

Figure 91. Boundary and forces for CFRP case number 5 - view 1. 

Figure 92.Boundary and forces for CFRP case number 5 - view 2. 
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Table 13. Detailed table of loads and restrictions for case 5 of the CFRP. 

Object Name 
Remote 

Disp 

Remote 

Disp 2 

Remote 

Disp 3 

Remote 

Disp 4 
Force 

Force 

2 

Force 

3 

Force 

4 

Force 

5 

Force 

6 

Definition 

Type Remote Displacement Force 

X 

Component 
0.01. m (ramped)  0. N (ramped) 

Y 

Component 
0.01. m (ramped)  14199 N (ramped) 

Z 

Component 
0. mm (ramped) 1.4775e+05 N  0. N (ramped) 

Rotation X 
0.1 ° 

(ramped) 
 

Rotation Y 
0. ° 

(ramped) 
 

Rotation Z 
0. ° 

(ramped) 
 

Suppressed No 

Behavior Deformable  

Rotation X  0.1 ° 

(ramped) 
 

Rotation Y  0. ° 

(ramped) 
 

Rotation Z  0. ° 

(ramped) 
 

Rotation X  0.1 ° 

(ramped) 
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Case 5  - Longitudinal loads – Results – Composite Frame; 

Total deformation: 

 

 

 

  

Figure 93. Total deformation 1 - CFRP - case 5. 

Figure 94. Total deformation 2 - CFRP - case 5. 
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Von-Misses stress: 

 

 

 

 

  

Figure 95. Von-misses stress 1 - CFRP - case 5. 

Figure 96. Von-misses stress 2 - CFRP - case 5. 
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Inverse fail factor: 

 

 

 

  

Figure 97. Inverse fail factor 1 - CFRP - case 5. 

Figure 98. Inverse fail factor 2 - CFRP - case 5. 
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Safety Factor: 

 

 

  

Figure 99. Safety factor - CFRP - case 5. 
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b. Appendix II– Steps needed in ANSYS to simulate 

both bogie frames. 

______________________________________________________________________ 

In appendix II we will go through all the steps that was needed to achieve the simulations 

for both the structure steel S235 and the composite bogie frames.  

That being said, the starting bogie is the Structure Steel S235 bogie frame. 

Structure Steel S235 bogie frame: 

The first bogie frame that was designed and simulated was the structure steel S235 bogie 

frame, out of both of the bogie frame, this one is considered the least complex and more 

straight foreward.  

Like mentioned previously in the memory, the bogie frame was initially designed and 

assembled using SolidWorks, later imported into ANSYS R19.2 using the IGES format. 

This format allows the models to be imported into ansys with SOLID geometry, great to 

start simulating.  

The first step to usig ANSYS is to oopen the Static Structural Analysis, for this you would 

need to go into the left tree of tools in the main ANSYS interface and select the Static 

Structural Analysis.  

Once you have selected the analysis you need to do the simulation, you would need to 

select the material that the model will have and for that you need to go into the 

Engineering Data that is visible in the box titled A.  

Figure 100. Screenshot of the main ANSYS interface with the Static Structural Analysis enabled. 
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Now that you are in the Engineering Data, you need to select the material by accessing 

the Engineering Data Sources on the top left of the screen (see red arrow and box in the 

figure above). Like we are first describing the steps for the structure steel s235, we will 

go and look for the structure steel material in the data source.  

 

Like mentioned previously in the memory, the properties given by the software ANSYS 

concerning the materials were detailed and good enough to use, that being said, to make 

the material fit into the narrative of using Structure Steel S235 the main properties for 

the structure steel will be modified so that it simulates that of the Structure Steel S235.  

Figure 101. Engineering data interface that is needed to select the materials present in the model. 

Figure 102. Information after clicking engineering data source. 
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To be able to select the structural steel you would need to click in the engineering data 

source tap General materials, and as you do so, a list of materials will pop-up in the bottom 

tap. In this list you will find the Structural Steel and by clicking the plus sign you will 

add it to the materials selected that will later on will be used in the simulation. It is worth 

mentioning that in the bottom tap you can see that the properties that the structure steel, 

of which ahead will be modified.  

Figure 103. Search for the structural steel in the General material section. 
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Once you select the material you leave Engineering Data Source by clicking once again 

in the top left bottom and it will exit you to the engineering data main interface. In this 

interface you can see that the Structural Steel was selected, and, in the bottom, you can 

notice that the properties are listed. These properties will be modified to that of the 

Structure Steel S235, in the appendix III is available the technical data sheet for the 

Structure Steel S235.  

 

The next step is to import the model, to do that you would need to right click on the the 

Geometry>Import Geometry>Ensabled Frame.IGS, remember that the imported models 

sometimes has some errors. These errors can arise when switching from one software to 

another and is convenient to deal with them at this stage of the simulation to safe 

headaches when trying to search for a convergence.  

To do this you need to go into geometry and do a few analysis to the model. To access 

the geometry interface (called SpaceClaim) you need to doble-click on the geometry tap 

and the interface will open up.  

 

 

Figure 104. Engineering data interface showing the materials that are selected for the simulation. 

Figure 105. Importing the model. 

Figure 106. Repair bar on top of the SpaceClaim interface. 
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Once you are in the SpaceClaim interface you would need to do some analysis on the 

model, as stated before the model sometimes imports itself with some underlying errors 

so you must fix them prior to any simulation. For this, you will go to the repair option 

(like in the figure on top) on the top of the screen and use all 3 available tools, stitch, 

gaps, and missing faces to fix the model in case that there is a need for it. Ideally there 

will be no need, but there is always room to dedicate a bit of time to fixing the model to 

prevent headaches ahead.  

After this, we will go over how to simulate the model using the ANSYS mechanical. To 

access it, you will need to go back into the ANSYS main interface from before and doble 

click the figure.  

from here on we will have to select a case study to explain the procedure, for this the 

study case that there has been selected is the case 5. This case is the more complete and 

has the majority of the forces that will be needed for the simulation.  

Figure 107. Main ANSYS interface. 
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Above is the figure of what we are aiming for, for this there are some previous steps that 

will be needed to take prior to start the simulations. The first thing that ANSYS 

mechanical needs from you is to declare the material for the model.  

 

On the left side of the screen is the model tree that will be used to simulate the model. 

This tree has all the tools necessary so that you can accurately achieve the goal. The 

interrogation marks that the tree has means that there is a need of an input to go ahead, as 

to that the first step is to choose the material of the geometry.  

Figure 109. Case 5, isometric view to see the forces and the restraints. 

Figure 108. overview of the ANSYS mechanical. 
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By clicking on geometry on the tree of tools, on the bottom top that is directly underneath 

appears a yellow highlighted box. This box will need your input to go ahead. The box 

asks you about the material of the part of the model you have selected, but because the 

model is all completely structural steel S235, then the fasted approach would be selecting 

everything at once and choosing the material to be structural steel. After doing so, you 

will have the following view of the model. 

 

Once the model has been correctly materialized, the next step would be the analysis of 

the connectors. Like mentioned previously, the model sometimes imports with some 

penetrations and errors, so when you do not fix the model, you may get some areas where 

there is too much pivoting (or freedom in a certain node of the model. To combat this, we 

previously passed the model in a repair face in SpaceClaim to avoid these problems. The 

proper way of knowing if you have a penetration or gap issue in the model is to go on the 

Contact on the tool tree, right-click, and select contact tool. Once there, you go on the 

Contact Tool, and right-click again to add the status option, once this is done you can 

initialize the contact analysis and the following figure is what you should have displayed 

on your screen. 

Figure 110. In grey the structure steel parts of the model. 
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As you can see there is no red, orange, or yellow warning signs that ANSYS is displaying, 

guaranteeing that the connections and results that will be given are accurate and reliable.  

The next step of the simulation is to do a mesh of the model, and the according meshing 

quality analysis for the model, this step will not be revised due to it being already gone 

over in the memory (Chapter. 9 ANSYS simulations).  

The subsequent step after the 

meshing of the model is adding the 

forces and restrains that the model 

needs to fulfill the simulation of case 

5. To do this, you will need to go on 

the tool tree on the left-hand side of 

the screen and right click on static 

structure. There will be many 

different options of forces that 

appear when doing this. Like you 

may notice, there are 3 different style 

of forces that are present in the 

model, starting with the gravitational 

force of the model itself. This force 

is the yellow force that appears in the 

figure above where you can see all 

the constraints and forces for the 

case 5 scenario. To add this force to 

the simulation, tool tree> static 

structure> Insert> standard earth 

gravity. 

Figure 111. Initial information of the status of the contact point and nodes on the model. 

Figure 112. Standard earth gravity. 
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The next force that is going to be 

added are the vertical forces, these 

forces are the forces transmitted 

by the secondary suspensions on 

top. These forces could be 

simulated by a spring force over 

an area, but it has been decided to 

simulate it in a way that the force 

goes from 0N to the goal in 

newtons gradually and over a 

surface that has been bumped 

upwards, to simulate the area of 

initial contact of the spring. This 

is a valid representation and an 

easier alternative to simulating a 

spring in ANSYS mechanical. 

Thus, to do this, you need to 

access the tool tree> static 

structure> Insert> Force. As you 

also may have noticed there are 

two vertical forces, and as such 

you would need to do this process 

two time, one for every vertical 

force. When adding the option force into the tool tree, on the bottom tap immediately 

under, you have to input the magnitude of the force and where this force will be located 

(you need to select the area where the force will be connecting with the model). In the 

memory of this project, it has been calculated that the vertical force will be of a magnitude 

of F = - 134388 N for the Z-axis. To do so, you must go into the option Defined By> 

Components, so you can have a X, Y, Z axis available. There in the Z-axis box, you input 

the value of the vertical force stipulated in the memory. You repeat this procedure for the 

other vertical force.  

Figure 113. Insertion of the vertical forces. 
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Lasty concerning the forces, 

we will need to input the 

remote forces on the bottom 

side of the frame replicating the 

forces that appear from the 

contact of the rails and the 

wheels of the train. As we are 

studying case 5, Lozenging 

forces, these are the 

longitudinal remote forces start 

their influence when braking 

and it has a magnitude of F = 

16628 N that is calculated in 

the memory of this project. 

Like you can see I the overview 

of case 5, there are 4 remote 

forces. These forces all have 

the same value and the same 

direction. Just like the previous 

forces, the way to activate these 

forces on the model is by tool 

tree> static structure> Insert> 

Remote Force. The difference 

from the force option, is that 

the remote force is used when the force is in a certain distance from the face, and just like 

we mentioned just, the forces that they simulate is that of the braking of the train and the 

contact point is where the wheels meet the rails.  

Now, we will proceed onto the constraints. The constraints on the model will be following 

the EN 13749:2011 standard as a guideline. The guideline mentions that there is a need 

for a level of freedom when supporting the frame, and as such, the selected amount of 

freedom follows the table ahead.  

Table 14. List of the restrictions for all the cases in the study of the composite bogie frame. 

  Support 1 Support 2 Support 3 Support 4 

Cases ↓ x [mm] y [mm] z [mm] x [mm] y [mm] z [mm] x [mm] y [mm] z [mm] x [mm] y [mm] z [mm] 

1 
10 10 0 10 10 0 10 10 0 10 10 0 

2 

3 10 10 0 10 10 10 10 10 0 10 10 10 

4 
10 10 0 10 10 0 10 10 0 10 10 0 

5 

Cases ↓ Rx [°] Ry [°] Rz [°] Rx [°] Ry [°] Rz [°] Rx [°] Ry [°] Rz [°] Rx [°] Ry [°] Rz [°] 

1 
0.1 0 0 0.1 0 0 0.1 0 0 0.1 0 0 

2 

3 0.1 0 0 0.1 0.1 0.1 0.1 0 0 0.1 0.1 0.1 

4 
0.1 0 0 0.1 0 0 0.1 0 0 0.1 0 0 

5 

Figure 114. Insertion of the longitudinal remote force. 
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There is an average 10mm amount of freedom to simplify the constrains. You can see 

that for case 5, there is horizontal and longitudinal freedom of 10 mm, but 0 mm of 

freedom vertically. Later, in the rotational aspect, there is 0.1 degrees of rational freedom 

for only the X-axis and the so that it can rotate longitudinally. Case 3 is the only case that 

does not follow this order, but it is because this case is the unloading scenario, where the 

forces are bit different and the restrictions as well.  

 

The method to including these 

restrictions to the model is very 

similar to the forces, you would 

initially need to go to tool tree> 

static structure> Insert> Remote 

Displacement. After doing so, you 

will be asked the amount of liberty 

you would want to give to the 

model (i.e., the liberty of the X, Y, 

and Z components and the Rotation 

of X, Y, and Z).  Select the faces, 

input the amount of freedom, and 

repeat 3 other more times until you 

reach a total of 4 times.  

Once that you have finalized the 

forces and constrains present in the 

simulation you will need to insert 

which are the solutions that you are 

looking for in the simulation, as this is a 

tension simulation, we will be looking 

for the Total deformation, Von-Misses stress, and the safety factor.  

To add the all the solutions mentioned previously you need to go into the tool tree one 

more time,  

Tool tree> Solutions> Insert> Deformation> Total 

Tool tree> Solutions> Insert> Stress> Equivalent (Von-Misses stress) 

Tool tree> Solutions> Insert> Stress Tool> Max Equivalent stress   

Figure 115. Insertion of the remote constrains for 

the bottom part of the frame. 
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Figure 116. Solution selection - Total deformation. 

Figure 117. Solution selection - Von-Misses Stress 

Figure 118. Solution selection - Safety factor 
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Above are screenshots that express visually the steps you need so that you can input the 

solutions that you are looking for. In this study, we were intersted in knowing the total 

deformation, the Von-Misses stress, and the safety factor of the model under the different 

scenerarios, to later put into comparison with the same scenearios but with the composite 

frame, and derive conclusions.  

With this last step we can now run the simulation and understand the results.  

Composite bogie frame: 

This study is also a comparison with a composite frame version, and as such, we need to 

explain the procedures that was needed to go through to complete the explaination 

chapter. In the memory, you can find the ACP (Pre) and the Mesh (mesh quality) for the 

composite frame, and so it will not be explained twice. 

To guarantee the fluent understanding of the composite ANSYS explanation, Case 5 will 

be choosen just as we choose it for the structure steel S235. 

Staring off, the setup for the composite frame is the folowing. 

In the above picture you can see a few differences with how the main interface looks, as 

a starters, the composite frame has linked 3 different modules. Starting off with the 

Geometry. The geometry module is the same as the SpaceClaim but it is sepeareted, it has 

the same function as it did in the the static structure for the structural steel S235 but it is 

outside of the main module. Next is the ACP (Pre) module, this module is only needed 

when you are constructing or using the composite format available in ANSYS. It does not 

have any other application is not to shape and create the composite ply that you desire, 

and only works with SHELL geometry too. Lastly is the static structural, this operates the 

same way it operates with the structrual steel S235.  

Figure 119. ANSYS main interface when finalized using it for the composite bogie frame. 
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To start the explanation, you will need to import the model that you would like to trasform 

into composite. ANSYS is very powerful, it allows to work with composite materials and 

to do so, you must import the model as a SHELL geometry model. By doing so, you can 

use the ACP (Pre) module that you will need to create the composite bogie frame. 

Just like in the previos case, you will need to use SpaceClaim to clean and repair the 

model, so that you do not have any error ahead. This step is very important specially when 

using ACP (Pre), and is always convenient to take into consideration when designing 

anything.  

Next you must go into the material selection aspect. Just like in the previous case, we 

access the materials that ANSYS has available by going into the Engineering Data. For 

this you must first add the ACP (Pre) into the main ANSYS interface, in the Component 

Systems you can locate the ACP (Pre) and you can add it by doble-click on it.  

You can link both modules by dragging the geometry module into the ACP (Pre) one, 

impporting that way the SpaceClaim repaired version of the model into the ACP (Pre) 

module. Afterwards,the next step is selecting the composite materials, in the study we 

have selected the existance of the Recycled Unidirectional Epoxy Carbon Fiber, Waved 

Epoxy Carbon Fiber, and the Aluminum Honeycomb. For that, just like in the structure 

steel S235 you need to go into the Engineering Data> Engineering Data Source  

 

Figure 120. Selection of the ACP (Pre) module. 
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Inside the Engineering Data source you will need to seach for the composites, the 

composite group of materials are located in the Composite materials, once in there is a 

selection of 23 composite materials that are available to use and modify. In this list are 

the materials that will be present in the composite model. Select them.  

Once all the three materials are selected, to accurately simulate the recycled version of 

the unidirectional epoxy carbon, we needed to change the properties according to the 

study found referenced in the memory document.  

After selecting the material and repairing the model, the ACP (Pre) module will be needed 

to be initiated, and to see the developemnt, refer to chapter. 9.2.1 ACP (Pre) module in 

the memory document. The ACP (Pre) module is needed to construct the composite plies, 

to select where and which are the directions of the primary orientations for the 

composites.  

Lastly, you need to link the ACP (Pre) module after the utilization of it with the Static 

Structural by connecting the Setup boc in the AC (Pre) with the model box on the Static 

Structural. 

 

Figure 121. Engineering Data interface. 
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The steps inside of the static structural module are exactly the same as the ones explained 

previously but the difference is that the Mesh is not the same as for the Structural steel 

S235 model, this being said, the mesh is shared with the other 5 cases that the composite 

bogie frame is put under. The explanation and demostration of the mesh formation is also 

explained in the memory document, chapter. 9.3 Meshing the composite frame.   

Figure 122. Connecting the ACP (Pre) module with the Static Structural module. 
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c. Appendix ⅡI – Technical drawings: 

_____________________________________________________________________ 

 

In this second section of the appendix, there is going to be a display all the technical 

drawings created after the designing both the composite and standard bogie frame. The 

technical drawings are going to follow the following order: Beams of both the composite 

and structure steel s235 bogie frame, connecting rod for composite bogie frame, 

connecting rod for the structure steel s235 bogie frame, assembled structure steel s235 

bogie frame, and finally assembled composite bogie frame. 
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______________________________________________________________________ 

To finalize appendix II, it is convenient to have a table that explains the geometrical 

tolerances that were present in the above technical drawings so that there is total 

comprehension.  

Table 15. list of geometrical tolerances found in the technical drawing above. 

Geometric characteristic Symbol 

Straightness 
 

Symmetry 

 

Parallelism 
 

Perpendicularity 
 

Coaxiality 
 

Positional 
 

Circularity 
 

Cylindricity 
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d. Appendix ⅢI - Technical data sheet of the materials 

in the study: 

_____________________________________________________________________ 

 

In this appendix IIII, we will go through the different technical data sheet of all the 

materials that took part in the study. All the tables that are present in this segment are 

taken from ANSYS report preview and are the properties that were used in the study of 

the bogie frame.   

Structure Steel S235: 

Staring of with the Structure Steel S235 which is a variation of structure steel of low 

carbon alloy. Ahead is the table describing in weight percentage the different elements 

that constitutes it. 

 
Table 16. List of the materials that make up Structure steel S235. 

Element Weight % 

Mn 1.4% 

Cu 0.55% 

C 0.17% 

P 0.04% 

S 0.035% 

N 0.01% 

 

The following table displays the mechanical and thermal properties that the Structure 

steel S235 has, it is important to have a full understanding of the mechanical behavior 

represented in the study.  

 
Table 17. Technical data sheet of the Structure steel S235 

Property Value Units 

Density  7850 kg ∙ m−3 

Isotropic Secant Coefficient of Thermal Expansion 1.2e-005 C˚−1 

Specific Heat Constant Pressure 434 J kg−1 ∙ C˚−1 

Isotropic Thermal Conductivity 60.5 W ∙ m−1 ∙ C˚−1 

Isotropic Resistivity 1.7e-007 Ohm ∙ m 

Compressive Yield Strength  2.35e+008 Pa 

Tensile Yield Strength 2.35e+008 Pa 

Tensile Ultimate Strength 4.6e+008 Pa 

Young's Modulus 2.35e+011 Pa 

Poisson's Ratio 0.28 - 

Shear Modulus 7.6923e+010 Pa 

Relative Permeability 10000 - 
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Zero-Thermal-Strain Reference Temperature C 20 C˚ 

 

Finally, the S-N curve for the structure steel S235 table will be displayed to give 

meaning to the life expectancy for the structure steel S235 bogie frame model.  

 
Table 18. S-N curve for the Structure steel S235. 

Alternating Stress Pa Cycles 

3.999e+009 10 

2.827e+009 20 

1.896e+009 50 

1.413e+009 100 

1.069e+009 200 

4.41e+008 2000 

2.62e+008 10000 

2.14e+008 20000 

1.38e+008 1.e+005 

1.14e+008 2.e+005 

8.62e+007 1.e+006 

 

Woven Epoxy Carbon Prepreg: 

The next material present in the study is the woven epoxy carbon prepreg being part of 

the materials that makes up the composite bogie frame. we will follow the same layout 

than the that of the structure steel s235.  

 

Starting with the mechanical and thermal technical data sheet available in the ANSYS 

software we have that: 

 
Table 19. Mechanical and Thermal properties of the Woven Epoxy Carbon Prepreg.  

Property Value Units 

Density  1420 kg ∙ m−3 

Isotropic Secant Coefficient of Thermal Expansion X 2.2e-006 C˚−1 

Isotropic Secant Coefficient of Thermal Expansion Y 2.2e-006 C˚−1 

Isotropic Secant Coefficient of Thermal Expansion Z 1.0e-005 C˚−1 

Young's Modulus X Direction 6.134e+010 Pa 

Young's Modulus Y Direction 6.134e+010 Pa 

Young's Modulus Z Direction 6.9e+009 Pa 

Poisson's Ratio XY  4.e-002 - 

Poisson's Ratio YZ 0.3 - 

Poisson's Ratio XZ 0.3 - 

Shear Modulus XY 1.95e+010 Pa 

Shear Modulus YZ 2.7e+009 Pa 

Shear Modulus XZ 2.7e+009 Pa 
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Orthotropic Strain Limits - Tensile X direction 1.26e-002 - 

Orthotropic Strain Limits - Tensile Y direction 1.26e-002 - 

Orthotropic Strain Limits - Tensile Z direction 8.e-003 - 

Orthotropic Strain Limits - Compressive X direction  -1.02e-002 - 

Orthotropic Strain Limits - Compressive Y direction  -1.02e-002 - 

Orthotropic Strain Limits - Compressive Z direction  -1.2e-002 - 

Orthotropic Strain Limits - Shear XY 2.2e-002 - 

Orthotropic Strain Limits - Shear YZ 1.9e-002 - 

Orthotropic Strain Limits - Shear XZ 1.9e-002 - 

Tensile X Direction 8.5e+008 Pa 

Tensile Y Direction 8.5e+008 Pa 

Tensile Z Direction 5.e+007 Pa 

Compressive X Direction  -5.09e+008 Pa 

Compressive Y Direction  -5.09e+008 Pa 

Compressive Z Direction  -1.7e+008 Pa 

Shear XY 1.25e+008 Pa 

Shear YZ 6.5e+007 Pa 

Shear XZ 6.5e+007 Pa 

Zero-Thermal-Strain Reference Temperature C 20 C˚ 

 

The fatigue properties were not taken into consideration for the making of the composite 

frame. 

Recycled UD Epoxy Carbon Prepreg: 

The following material is the recycled unidirectional epoxy carbon prepreg, it is also 

one of the carbon composite materials that makes up the composite bogie frame and as 

such, it is worth describing its mechanical and thermal properties of it.  

 

The following table displays the thermal and mechanical property of the recycled 

unidirectional epoxy carbon prepreg. For the creation of the recycled unidirectional 

epoxy carbon prepreg material, the data accessible through ANSYS was modifies based 

on the results found in the study referenced in the memory, where in the study it is 

demonstrated that the recycled version lost 3.2% of the Young’s Modulus and a 14% in 

the Tensile Strength. As such, the data available in the software ANSYS was modified 

reducing 14% the TS and 3.2% the YM to represent it in the simulation.  

 
Table 20. List the mechanical and thermal properties for the Recycled UD epoxy carbon that was used in the 

simulation of the composite frame. 

Property Value Units 

Density  1490 kg ∙ m−3 

Isotropic Secant Coefficient of Thermal Expansion X -4.7e-007 C˚−1 

Isotropic Secant Coefficient of Thermal Expansion Y 3.e-005 C˚−1 

Isotropic Secant Coefficient of Thermal Expansion Z 3.e-005 C˚−1 

Young's Modulus X Direction 1.171e+011 Pa 
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Young's Modulus Y Direction 8.3226e+009 Pa 

Young's Modulus Z Direction 8.3226e+009 Pa 

Poisson's Ratio XY  0.27 - 

Poisson's Ratio YZ 0.4 - 

Poisson's Ratio XZ 0.27 - 

Shear Modulus XY 4.7e+009 Pa 

Shear Modulus YZ 3.1e+009 Pa 

Shear Modulus XZ 4.7e+009 Pa 

Orthotropic Strain Limits - Tensile X direction 1.67e-002 - 

Orthotropic Strain Limits - Tensile Y direction 3.2e-003 - 

Orthotropic Strain Limits - Tensile Z direction 3.2e-003 - 

Orthotropic Strain Limits - Compressive X direction  -1.08e-002 - 

Orthotropic Strain Limits - Compressive Y direction  -1.92e-002 - 

Orthotropic Strain Limits - Compressive Z direction  -1.92e-002 - 

Orthotropic Strain Limits - Shear XY 1.2e-002 - 

Orthotropic Strain Limits - Shear YZ 1.1e-002 - 

Orthotropic Strain Limits - Shear XZ 1.2e-002 - 

Tensile X Direction 1.9128e+009 Pa 

Tensile Y Direction 2.49e+007 Pa 

Tensile Z Direction 2.49e+007 Pa 

Compressive X Direction  -1.082e+009 Pa 

Compressive Y Direction  -1e+008 Pa 

Compressive Z Direction  -1e+008 Pa 

Shear XY 6.e+007 Pa 

Shear YZ 3.2e+007 Pa 

Shear XZ 6.e+007 Pa 

Zero-Thermal-Strain Reference Temperature 20 C˚ 

 

Like before, the fatigue properties were not taken into consideration for the making of 

the composite frame. 

 

Aluminum Honeycomb: 

The next and last material present in the composite bogie frame, is the Aluminum 

honeycomb. Just like in the previous sections of this appendix, the mechanical 

properties of the aluminum honeycomb will be displayed. 

 

The following table of properties is a list of mechanical properties that were used for the 

honeycomb and therefor to help construct the composite bogie frame.  
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Table 21. List the mechanical properties for the Aluminum honeycomb that was used in the simulation of the 

composite frame. 

Property Value Units 

Density  80 Kg ∙ m−3 

Young's Modulus X Direction 1.e+006 Pa 

Young's Modulus Y Direction 1.e+006 Pa 

Young's Modulus Z Direction 2.55e+008 Pa 

Poisson's Ratio XY 0.49 - 

Poisson's Ratio YZ 1.e-003 - 

Poisson's Ratio XZ 1.e-003 - 

Shear Modulus XY 1 Pa 

Shear Modulus YZ 3.7e+007 Pa 

Shear Modulus XZ 7.e+007 Pa 

Orthotropic Strain Limits - Tensile X Direction 0 - 

Orthotropic Strain Limits - Tensile Y Direction 0 - 

Orthotropic Strain Limits - Tensile Z Direction 5.31e+006 - 

Orthotropic Strain Limits - Compressive X Direction  0 - 

Orthotropic Strain Limits - Compressive Y Direction  0 - 

Orthotropic Strain Limits - Compressive Z Direction  -5.31e+006 - 

Orthotropic Strain Limits - Shear XY 0 - 

Orthotropic Strain Limits - Shear YZ 1.21e+006 - 

Orthotropic Strain Limits - Shear XZ 2.24e+006 - 

 

 


